
Oracle® Cloud
Using Oracle HCM Cloud Adapter

Release 12.1.3

E65431-01

August 2015



Oracle Cloud Using Oracle HCM Cloud Adapter, Release 12.1.3

E65431-01

Copyright © 2015, Oracle and/or its affiliates. All rights reserved.

Primary Author: Mark Kennedy

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software,
any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
"commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications that
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron,
the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services unless
otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates
will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party
content, products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents

Preface ................................................................................................................................................................. v

Audience ........................................................................................................................................................ v

Documentation Accessibility ...................................................................................................................... v

Related Resources ......................................................................................................................................... v

Conventions.................................................................................................................................................. vi

1    Introduction to Oracle HCM Cloud Adapter

Differences Between Using Oracle Cloud Adapters in the Cloud and On-Premises

Environments....................................................................................................................................... 1-1

Oracle HCM Cloud................................................................................................................................... 1-1

Installing the Cloud Adapters................................................................................................................. 1-2

Performing Postinstallation Configuration Tasks................................................................................ 1-2

Specifying the Oracle HCM Cloud Service Catalog Service WSDL.................................................. 1-2

Obtaining the Authentication Credentials ............................................................................................ 1-5

Unsupported Features ............................................................................................................................. 1-5

Restrictions................................................................................................................................................. 1-6

2    Understanding Oracle HCM Cloud Adapter Features

Adapter Architecture ............................................................................................................................... 2-1

Designing an Integration with the Adapter Configuration Wizard ................................................. 2-3

Monitoring Your Application During Runtime ................................................................................... 2-5

Understanding Oracle HCM Cloud Adapter Design Integration Patterns ..................................... 2-5

3    Designing SOA Composite Applications

Creating a SOA Composite Application ............................................................................................... 3-1

Adding an Adapter to a SOA Composite Application as a Service or Reference........................... 3-1

Completing Design of a SOA Composite Application........................................................................ 3-3

4    Designing Oracle Service Bus Business Services

Creating an Oracle Service Bus Business Service................................................................................. 4-1

Adding an Adapter to a Business Service as a Service or Reference ................................................ 4-1

Completing Design of an Oracle Service Bus Business Service ......................................................... 4-3

iii



5    Configuring Oracle HCM Cloud Properties

Configuring Basic Information Properties ............................................................................................ 5-1

What You Can Do from the Basic Info Page................................................................................. 5-2

What You See on the Basic Info Page ............................................................................................ 5-2

Configuring Oracle Cloud Adapter Connection and CSF Key Properties....................................... 5-2

What You Can Do from the Oracle Cloud Adapter Connection Page ..................................... 5-3

What You See on the Oracle Cloud Adapter Connection Page................................................. 5-3

What You Can Do from the Oracle Cloud Adapter CSF Key Page .......................................... 5-4

What You See on the Oracle Cloud Adapter CSF Key Page...................................................... 5-4

Configuring Oracle HCM Cloud Source Request Properties............................................................. 5-5

What You Can Do from the Oracle HCM Cloud Source Request Page ................................... 5-5

What You See on the Oracle HCM Cloud Source Request Page............................................... 5-5

Configuring Oracle HCM Cloud Source Response Properties .......................................................... 5-6

What You Can Do from the Oracle HCM Cloud Source Response Page ................................ 5-6

What You See on the Oracle HCM Cloud Source Response Page ............................................ 5-6

Configuring Oracle HCM Cloud Target Operation Properties ......................................................... 5-7

What You Can Do from the Oracle HCM Cloud Target Operations Page .............................. 5-7

What You See on the Oracle HCM Cloud Target Operations Page.......................................... 5-8

Reviewing Configuration Values on the Summary Page ................................................................... 5-8

What You Can Do from the Summary Page ................................................................................ 5-8

What You See on the Summary Page ............................................................................................ 5-9

6    Managing Applications

Managing the Application in Oracle Enterprise Manager Fusion Middleware Control ............... 6-1

Testing Oracle Service Bus Business Services from Oracle Service Bus Console............................ 6-2

iv



Preface

Using Oracle HCM Cloud Adapter describes how to use the Oracle HCM Cloud adapter
in your SOA composite applications and Oracle Service Bus business services.

Topics:

• Audience

• Documentation Accessibility

• Related Resources

• Conventions

Audience
Using Oracle HCM Cloud Adapter is intended for users who want to create, deploy, test,
and monitor applications that use the Oracle HCM Cloud adapter.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Resources
For more information, see these Oracle resources:

• Developing SOA Applications with Oracle SOA Suite

• Administering Oracle SOA Suite and Oracle Business Process Management Suite

• Administering Oracle Service Bus

• Understanding Technology Adapters

v
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

vi



1
Introduction to Oracle HCM Cloud Adapter

This section describes the Oracle HCM Cloud adapter.

Topics

• Differences Between Using Oracle Cloud Adapters in the Cloud and On-Premises
Environments

• Oracle HCM Cloud

• Installing the Cloud Adapters

• Performing Postinstallation Configuration Tasks

• Specifying the Oracle HCM Cloud WSDL

• Obtaining the Authentication Credentials

• Unsupported Features

• Restrictions

Differences Between Using Oracle Cloud Adapters in the Cloud and On-
Premises Environments

There may be differences between using Oracle cloud adapters in the cloud and on-
premises environments that impact the information described in this guide.

For information about differences, see Using Oracle SOA Suite Cloud Service and 
Known Issues for Oracle SOA Suite Cloud Service.

Oracle HCM Cloud
The Oracle HCM Cloud adapter enables you to create an integration with Oracle
Human Capital Management (HCM) Cloud applications. You select business objects
that an integration receives from Oracle HCM Cloud as a request and as a response.

The Oracle HCM Cloud adapter enables customers to easily integrate their on-
premises or SaaS applications with Oracle HCM Cloud without having to know about
the specific details involved in the integration.

The Oracle HCM Cloud adapter provides the following benefits:

• Integrates easily with the Oracle HCM Cloud application’s WSDL file to produce a
simplified, integration-centric WSDL.

• Generates automatic mapping to the exposed business object that you select during
adapter configuration:
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– Business object: Represents a self-contained business document that can be
acted upon by the integration. An integration can send requests to create a new
record for that business object. They can send a request either to update or
delete an existing record for a business object. Integrations can also send
requests to retrieve information about one or more records representing that
business object.

• Automatically handles security policy details required to connect to the Oracle
HCM Cloud application.

• Provides standard error handling capabilities.

Integration with Oracle Fusion Applications may involve several design-time and
runtime considerations that require users to manually build and manage additional
logic into their integration for authentication, session management, fault handling,
data transformation mappings, and so on. The Oracle HCM Cloud adapter reduces the
cost of building and maintaining this complex logic with out-of-the-box features such
as a graphical, point-and-click, wizard-based designer. The Oracle HCM Cloud
connection:

• Interacts at runtime with the publicly-exposed Oracle HCM Cloud business objects
to perform operations defined on them.

• Provides contextual information to the developer at design time about the business
objects and services available for integration.

For more information, see Configuring Oracle HCM Cloud Properties.

Installing the Cloud Adapters
See the README.txt available with the patch for instructions on installing the cloud
adapters.

After you complete adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

Note:   For information about supported versions and platforms, see the
release certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud
adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Specifying the Oracle HCM Cloud Service Catalog Service WSDL
You must specify a mandatory Oracle HCM Cloud service catalog service WSDL for
accessing business objects.

Obtaining the Service Cloud Service WSDL

A mandatory Oracle HCM Cloud service catalog service WSDL is required for
accessing business objects. The service catalog service WSDL is required to configure
the adapter for both inbound and outbound endpoints using either business objects or
business services.

Installing the Cloud Adapters
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WSDL Requirements Where Do You Get the WSDL

The URL must be that of a service catalog
service WSDL. The service catalog service
enables clients to retrieve information about
all public Oracle Fusion Application service
endpoints available for that instance. The
information it returns is specific to the
particular cloud instance and also reflects the
new services that may have been introduced
in patches applied to the instance. This
service is used to programmatically discover
the SOAP services available on the cloud
instance and retrieve the necessary metadata
to invoke the SOAP services to manage
business objects.

The developer creating an Oracle HCM
Cloud connection must work with the Oracle
HCM Cloud service administrator to get the
concrete WSDL URL for the service catalog
service provisioned for the specific SaaS
application. The concrete WSDL URL must be
supplied while creating the connection.

Prerequisites

This section describes how to derive the external virtual host and port for a tokenized
service WSDL. The topology information in the Topology Registration setup task
contains the external virtual host and port for the domains and applications. The
following instructions describe the steps for deriving the values using the service
catalog service WSDL URL as an example: http://atf_server:port/
fndAppCoreServices/ServiceCatalogService.

To access the Review Topology page, the
ASM_REVIEW_TOPOLOGY_HIERARCHY_PRIV entitlement must be granted to the
user's job role. The entitlement is granted to the
ASM_APPLICATION_DEPLOYER_DUTY duty role, which is inherited by the duty
roles ASM_APPLICATION_DEVELOPER_DUTY and
ASM_APPLICATION_ADMIN_DUTY.

If the menu items and tasks described in the following procedure are not available in
your cloud instance, your user account is missing the required role. Contact your
cloud instance security administrator for assistance.

1. Log in to the cloud instance.

2. Click the Navigator icon in the global area in the top part of the window, then
chose Setup and Maintenance under the Tools heading.

3. Select Review Topology under the Topology Registration section in the Tasks
regional area on the left side of the window.

4. Click the Detailed tab in the middle of the window.

The tab shows the list of domains configured in the cloud instance.
 

Specifying the Oracle HCM Cloud Service Catalog Service WSDL
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5. Map the token name for the service path value to the domain name in the
Topology Manager:

Token Name in Service Path Domain Name

atf_server CommonDomain

crm_server CRMDomain

fin_server FinancialDomain

hcm_server HCMDomain

ic_server ICDomain

prc_server ProcurementDomain

prj_server ProjectsDomain

scm_server SCMDomain

6. Expand the domain name and select any external virtual host and port for the
J2EE applications that are deployed on the domain. In the sample window, the
values for this particular instance are fs-your-cloud-hostname and 443,
respectively.
 

Specifying the Oracle HCM Cloud Service Catalog Service WSDL
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7. Replace the domainName_server:PortNumber with the external virtual host
and port identified in the previous step. For example:

https://fs-your-cloud-hostname:port/fndAppCoreServices/
ServiceCatalogService?wsdl

Obtaining the Authentication Credentials
Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper and Oracle Enterprise
Manager Fusion Middleware Control from your SOA domain administrator. These
credentials are required for most cloud adapters. For the Oracle Eloqua Cloud adapter,
the credentials require three properties (company, username, and password).

Unsupported Features
The adapter does not support the following features:

• Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval

• Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion
Middleware Control

• Rejected message handling

• The following message encryption and decryption features available when you
right-click a cloud adapter in the Exposed Service swimlane or External
References swimlane in Oracle JDeveloper:

– Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

– Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

Obtaining the Authentication Credentials
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Restrictions
Note the following restrictions:

Not all Oracle Fusion Application services are available in SaaS mode because the
Oracle Fusion Application topology splits visibility to web and service resources into
two categories: internal and external. Therefore, some services are internal and cannot
be used by the adapter for integration. Only external services are available for public
consumption.

The adapter cannot be used for integrating the interfamily modules, because services
defined on them are not external services.

Restrictions
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2
Understanding Oracle HCM Cloud Adapter

Features

The Oracle HCM Cloud adapter provides the following features.

Topics

• Adapter Architecture

• Understanding Oracle HCM Cloud Adapter Design Integration Patterns

• Designing an Integration with the Adapter Configuration Wizard

• Monitoring Your Application During Runtime

Adapter Architecture
The adapter includes the following key features.

Service Catalog Service

The WSDL URL that you specify during adapter configuration must be that of a
service catalog service WSDL. The service catalog service is a Fusion Application
service that returns a list of external services available for integration. The service
catalog service provides the following features:

• Provisioned on the cloud instance.

• Provides public external service information for the specific cloud instance. It
reflects new services introduced in patches and customizations.

• Gets the endpoint and metadata for public external services on the cloud instance
on which the service catalog service is provisioned. The information that it returns
is specific to the particular cloud instance and reflects new services that may have
been introduced in patches applied to the instance. Oracle Fusion Applications in
the Oracle Applications cloud enable partners and customers to use this service to
programmatically discover the SOAP services available on the cloud instance and
retrieve the necessary metadata to invoke the SOAP services to manage business
objects.

Business Objects

The business object that the service implements is composed of a hierarchy of logical
entities that contain a collection of attributes. As an example, the opportunity service is
defined on the opportunity business object. The opportunity business object consists of
many entities such as an opportunity contact and opportunity lead. The business
object is the functional object on which the service operates. Examples include
opportunity, sales account, sales lead, marketing campaign, and sales forecast. 
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Business Object Notation

The business objects are grouped into related objects that are in turn grouped into
higher-level related objects. For example, the opportunity service business object
contains the following value:

• CRM : Opportunity Management : Opportunity

The above value means the service operates on the opportunity object. The
opportunity object is grouped into a related set of objects called opportunity
management that in turn is grouped into a larger set of related objects called CRM
(Customer Relationship Management). Other business objects included in the
opportunity management grouping are sales method and sales revenue. Other logical
business object groups in CRM are lead management and partner management.

Life Cycle of Business Object Services

The business object service goes through three life cycle phases:

• Active: This phase starts when the service is first delivered and lasts until it is
deprecated. 

• Deprecated: A service may be deprecated when it is superseded by a newer version
of the service or there is a planned obsolescence in a future release. The deprecated
status means that the service is still supported, but becomes obsolete in a later
release.

Deprecated services do not mean they are not supported. They continue to be
supported until they become obsolete. Deprecated services must go through the
deprecation cycle during which users are told that the service is going to be
withdrawn at a future time. However, it is still a service that must be supported.

If a selected business object or service has a life cycle value of deprecated, a
warning message is displayed. If the business object or service captures
information about a replacement business object or service, then it may also be
displayed. This information comes from the annotation element in the service’s
WSDL.

A portion of a service WSDL is shown below.

<wsdl:documentation xmlns:oer="http://xmlns.oracle.com/oer">
<name>Opportunity Service</name>
<description>A service to create, update, get, find, or delete opportunities.
 WARNING: This service will be deprecated and replaced with a newer version in 
the upcoming release.</description>
<oer:lifecycle>Active</oer:lifecycle>
<oer:compatibility>Supported - Backward Compatibility Assured</oer:compatibility>
. . .
<oer:category name="lbo">
<value>CRM-CRM : MOO-Opportunity Management : MOO_OPPORTUNITY-Opportunity</value>
</oer:category>
</wsdl:documentation>

New service consumers should consume the newer active version of the service
and existing customers should migrate to the newer active version of the service.

• Obsolete: The service is no longer shipped or supported. 

Adapter Architecture
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Supportability

The public external SOAP services are supported throughout their life cycle until they
are obsolete. Conversely, services that are considered private and not intended for
partners and customers to consume are not supported.

Cloud Services

The cloud web services (for example, for Oracle Sales Cloud or Oracle HCM Cloud)
provide access to an application programming interface (API) that companies can use
to build programs to integrate with the cloud (for example, Oracle Sales Cloud or
Oracle HCM Cloud). The API consists of a set of WSDL files that describes the
interface to the cloud objects. This provides a programmatic interface for accessing
cloud information (for example, for Oracle Sales Cloud or Oracle HCM Cloud). A
customer application can use the WSDL files through standard web services
development tools. The web services API allows companies to build programs to
integrate with the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud).

Some common examples of client integrations include integrations of CRM and back-
office applications. You can retrieve real-time sales and marketing information from
the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud) and use it in
financial and other back-office applications. For example, you can retrieve information
about recently closed opportunities through the web services interface and insert this
information into an order entry system that has a web services user interface. In
addition, you can store information from back-office applications for instant access by
users, which is visible in custom fields.

Security

Prior to accessing the fusion web services, user credentials must be supplied in
compliance with the security policies attached to the cloud services (for example,
Oracle Sales Cloud or Oracle HCM Cloud). Upon successful authentication, the user is
logged in and can issue web service requests to access and retrieve data. All cloud web
services are stateless (for example, Oracle Sales Cloud or Oracle HCM Cloud) such
that each web service call is an atomic transaction and is not associated to a persistent
session. Management of the stateless web service calls is handled by the underlying
fusion framework and is abstracted from the end user.

Designing an Integration with the Adapter Configuration Wizard
This section describes the design time and runtime aspects of using the Oracle HCM
Cloud adapter.

You use the Adapter Configuration Wizard to include the Oracle HCM Cloud adapter
in a SOA composite application or an Oracle Service Bus business service. The wizard
consists of configuration pages that create the artifacts required to communicate with
the Oracle HCM Cloud application. You can configure the adapter in the inbound
(source) direction or the outbound (target) direction.

• Inbound (source) direction:

The Basic Info page prompts you to enter a meaningful name and optional
description.

The Connection page prompts you to specify the WSDL, security policy, and
authentication key to use. The authentication key is created by clicking the Add
icon to specify the key name, user name, and password. You must also specify
these same values in Oracle Enterprise Manager Fusion Middleware Control. You
can also test the connection to the Oracle HCM Cloud application on the
Connection page. This enables you to confirm that the URL to the service catalog

Designing an Integration with the Adapter Configuration Wizard
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service and credentials are correct. Status is displayed that indicates whether the
connection is successful and whether the credentials are authenticated by the
Oracle HCM Cloud application. Any errors that occurred during the attempt to
connect are also displayed.

The Request page prompts you to select the business object to receive as a request
from the Oracle HCM Cloud Application.

To get all available data objects in the Oracle Sales Cloud instance, the adapter first
reads the schema document (.XSD) that is referenced in the service’s WSDL. The
adapter then parses this XSD to obtain the list of all schema imports and shows
them as data objects.

For example, the adapter displays the opportunity business object and its useful
metadata first by reading the opportunity service’s WSDL and the referenced
schema OpportunityService.xsd file. The XSD in turns imports another
schema Opportunity.xsd in which the opportunity business object is defined.
The metadata for the opportunity business object is defined in this schema.

A search facility is provided that enables you to filter the display of business
objects for quick selection. When you enter a search string, the list renders only the
matching business objects in the list browser instead of showing all objects.

The Response page prompts you to select the business object for the integration to
send as a response document to the Oracle HCM Cloud application. To send no
response, deselect the Send checkbox. You can also optionally select to send an
immediate response back to the Oracle Sales Cloud application. An immediate
response indicates a conversational response. For an immediate response, you can
select any of the data objects as a response document. You also can select to send
fault details with the immediate response.

The Summary page displays your selections.

• Outbound (source) direction:

The Basic Info page prompts you to enter a meaningful name and optional
description. This is the same page as is displayed for the inbound direction.

The Operations page prompts you to select a business object or service and the
operation to perform on your selection.

A search facility based on service names is also provided. To quickly select a
business service, you type a search string. The list renders only matching business
services in the list browser instead of showing all services.

The Summary page displays your selections for the outbound direction.

The following artifacts are created for each adapter instance in the Applications
window in Oracle JDeveloper:

• WSDL file: Only the standard WSDL file type is supported.

• JCA file: Contains the internal implementation details used by the adapter during
runtime. It contains the different interaction and connection properties used by the
adapter.

When application configuration is complete, you can deploy the application from
Oracle JDeveloper to the runtime environment.

Designing an Integration with the Adapter Configuration Wizard
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Note:    The wizard does not support the creation of response message
callbacks. As an alternative, you can design your BPEL process to include
activities that support callbacks.

For information about the details to specify in the fields of the wizard pages, see 
Configuring Oracle HCM Cloud Connection Properties.

Monitoring Your Application During Runtime
This section describes the design time and runtime aspects of using the Oracle HCM
Cloud adapter.

Runtime

You use the runtime part of the adapter for delivering the information generated
during design time to the service endpoint. You can monitor your SOA composite
application or Oracle Service Bus business service from Oracle Enterprise Manager
Fusion Middleware Control. You can also test your Oracle Service Bus business
service from Oracle Service Bus Console.

Understanding Oracle HCM Cloud Adapter Design Integration Patterns
Oracle HCM Cloud adapter supports the following design integration patterns in the
Adapter Configuration Wizard.

Outbound Integration from Oracle HCM Cloud Adapter into the Oracle HCM
Cloud Application

• You configure the Oracle HCM Cloud adapter to connect to the Oracle HCM Cloud
application.

• You navigate through the set of available business objects (standard and custom)
and select an operation to invoke the object. You can also use the search facility to
locate a business object.

• You save the adapter configuration and exit the Adapter Configuration Wizard.

• You map the application business object with the logical business object of the
Oracle HCM Cloud.

• You complete the design of the SOA composite application.

At runtime, the SOA composite application performs the selected operation on the
business object on Oracle HCM Cloud using the Oracle HCM Cloud adapter.

Inbound Integration into Oracle HCM Cloud Adapter from the Oracle HCM Cloud
Application

The Oracle HCM Cloud adapter can also be configured for inbound connectivity. For
example, you may want to integrate an on-premise application with the Oracle HCM
Cloud application by defining an inbound service interface using the Oracle HCM
Cloud adapter. This service is then invoked by Oracle HCM Cloud.

• You define an inbound service interface to be invoked by Oracle HCM Cloud.

• You configure a service endpoint by browsing through a list of objects. You select
the business object to receive from Oracle HCM Cloud as a request payload to this
SOA composite application.

• You complete the Oracle HCM Cloud adapter configuration.

Monitoring Your Application During Runtime
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• You complete the design of the SOA composite application as per the business
requirements.

Understanding Oracle HCM Cloud Adapter Design Integration Patterns
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3
Designing SOA Composite Applications

This section describes how design a Oracle SOA composite application with the Oracle
HCM Cloud adapter in Oracle JDeveloper.

Topics

• Creating a SOA Composite Application

• Adding an Adapter to a SOA Composite Application as a Service or Reference

• Completing Design of a SOA Composite Application

Creating a SOA Composite Application
This section provides an overview of how to create a SOA composite application in
which to include the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select SOA Application from the Items list, then click
OK. The SOA Create SOA Application wizard is displayed.

4. Specify an application name, and click Next.

5. Specify a project name, and click Next.

6. Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite
Editor.

Adding an Adapter to a SOA Composite Application as a Service or
Reference

You can add an Oracle HCM Cloud adapter to a SOA composite application as an
inbound (source) service to the Exposed Services swimlane or as an outbound (target)
reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.

2. Go to the Cloud section under Custom/Third Party.

The adapters are displayed.
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3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) service, drag the adapter to the Exposed Services
swimlane, and see the following sections that describe the wizard pages for
configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle HCM Cloud Source Request Configuration Properties

• Configuring Oracle HCM Cloud Source Response Configuration Properties

• Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) reference, drag the adapter to the External
References swimlane, and see the following sections that describe the wizard
pages for configuring the adapter.

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle HCM Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

Adding an Adapter to a SOA Composite Application as a Service or Reference
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Completing Design of a SOA Composite Application
This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a. Connect the BPEL process to the adapter. For this example, the BPEL process is
connected to the adapter as an external reference:

b. Design the contents of the BPEL process. For example:

i. Double-click the BPEL process.

ii. Add and configure an invoke activity to invoke the adapter.

iii. Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.

iv. Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA
Composite Editor.

For specific information about creating and designing SOA composite applications,
see Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:

Note:   You cannot use Oracle JDeveloper to deploy a SOA composite
application to Oracle SOA Suite Cloud Service. For information about other
deployment options, see Using Oracle SOA Suite Cloud Service.

a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite
application to the application server.

Completing Design of a SOA Composite Application
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4
Designing Oracle Service Bus Business

Services

This section describes how to design an Oracle Service Bus business service with the
adapter in Oracle JDeveloper.

Topics

• Creating an Oracle Service Bus Business Service

• Adding an Adapter to a Business Service as a Service or Reference

• Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service
This section provides an overview of how to create an Oracle Service Bus business
service in which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select Service Bus Application from the Items list, then
click OK.

4. Specify an application name, and click Next.

5. Specify a project name.

6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle
Service Bus Overview Editor.

Adding an Adapter to a Business Service as a Service or Reference
You can add the adapter to an Oracle Service Bus business service as an inbound
(source) proxy service to the Proxy Services swimlane or as an outbound (target)
external service to the External Services swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your Oracle Service Bus business service.

2. Go to the Cloud section under Service Bus.

The adapters are displayed.
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3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) proxy service, drag the adapter to the Proxy
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle HCM Cloud Source Request Configuration Properties

• Configuring Oracle HCM Cloud Source Response Configuration Properties

• Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) external service, drag the adapter to the External
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle HCM Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

Adding an Adapter to a Business Service as a Service or Reference
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Completing Design of an Oracle Service Bus Business Service
This section provides an overview of how to complete design of your Oracle Service
Bus business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

a. In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.

b. Enter a name for the pipeline and select the project location, then click Next

c. Select WSDL as the Service Type.

d. To the right of the WSDL selection, click the Browse icon to select the WSDL.

e. Select Application.

f. Expand Resource Chooser and select the WSDL file, then click OK.

g. Ensure that Expose as a Proxy Service is selected.

h. From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview
Editor.

i. Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing
Properties tab at the bottom of the dialog.

The outbound project is ready for deployment.

4. Deploy the business service.

Note:   You cannot use Oracle JDeveloper to deploy a business service to
Oracle SOA Suite Cloud Service. For information about other deployment
options, see Using Oracle SOA Suite Cloud Service.

a. Select the project, then select Deploy to Service Bus Server.

b. Follow the steps in the deployment wizard.

Completing Design of an Oracle Service Bus Business Service
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5
Configuring Oracle HCM Cloud Properties

The Oracle HCM Cloud connection enables you to create integrations with an Oracle
HCM Cloud application.

The following sections describe the wizard pages that guide you through
configuration of the Oracle HCM Cloud adapter as a source and target in an
integration.

Topics

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle HCM Cloud Source Request Properties

• Configuring Oracle HCM Cloud Source Response Properties

• Configuring Oracle HCM Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

Note:   If a selected business object or service has a life cycle value of
deprecated, a warning message is displayed. If the business object or service
captures information about a replacement business object or service, then it
may also be displayed. This information comes from the annotation element in
the service’s WSDL.

For more information about Oracle HCM Cloud, see Oracle HCM Cloud.

Configuring Basic Information Properties
You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics

• What You Can Do from the Basic Info Page

• What You See on the Basic Info Page
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What You Can Do from the Basic Info Page
You can specify the following values on the source or target Basic Info page. The Basic
Info page is the initial wizard page that is displayed whenever you drag an adapter to
the source or target area.

• Specify a meaningful name.

• Specify a description of the responsibilities.

What You See on the Basic Info Page
The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the connection. For example, if
you are creating a source Oracle RightNow
Cloud connection, you may want to name it
RightNowInboundDirection. You can
include English alphabetic characters,
numbers, underscores, and dashes in the
name. You cannot include the following:
• Blank spaces (for example, My RightNow

Connection)
• Special characters (for example,  #;83& or

righ(t)now4)
• Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an

inbound request to synchronize

account information with Oracle

Sales Cloud.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

• What You Can Do from the Oracle Cloud Adapter Connection Page

What You See on the Oracle Cloud Adapter Connection Page

• What You Can Do from the Oracle Cloud Adapter CSF Key Page

• What You See on the Oracle Cloud Adapter CSF Key Page

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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What You Can Do from the Oracle Cloud Adapter Connection Page
You can specify the following connection values for the Oracle Cloud adapter.

• Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua
Cloud adapter, no WSDL is required.

• Specify the security policy.

• Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,
inbound).

What You See on the Oracle Cloud Adapter Connection Page
The following table describes the key information on the Oracle Cloud adapter
Connection page.

Element Description

WSDL URL Note: This field is not displayed for the
Oracle Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to
build integrations specific to your instance.
You can also select the WSDL from a file
system or another source by choosing the
browser icon next to the WSDL URL field.
Click File System at the top of the dialog,
then browse for the WSDL.

Security Policy Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

• The wizard shows all policies, including
those that may not be applicable. To make
a correct selection, you must have a
knowledge of policies. For example, you
cannot select a SAML-based policy
because the identity is not propagated.

• The policies you apply to the cloud
adapter are unique to the cloud adapter
and do not impact other endpoints in the
composite.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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Element Description

Authentication Key Select the CSF authentication key.

• Add: Click to create a new authentication
key. You must specify the key name, user
name, and password. To successfully
deploy and administer your application,
you must specify these same values in
Oracle Enterprise Manager Fusion
Middleware Control.

• Edit: Click to edit an authentication key.
• Delete: Click to delete an authentication

key.

Test Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

• CSF key name

• Company name for the Oracle Eloqua Cloud adapter only.

• User name and password

What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF
Key page.

Element Description

CSF Key Name Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle HCM application). This key
identifies your login credentials during
design-time. To successfully deploy and
administer your application, you must
specify these same values in Oracle
Enterprise Manager Fusion Middleware
Control. For instructions, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Company Name Note: This field is only displayed for the
Oracle Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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Element Description

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle HCM application). Your
administrator provides you with user
credentials.

Password Enter the password for connecting to your
application.

Re-enter Password Re-enter the same password a second time.

Configuring Oracle HCM Cloud Source Request Properties
Enter the Oracle HCM Cloud source request values for your integration. The values
you specify start the integration.

Topics

• What You Can Do from the Oracle HCM Cloud Source Request Page

• What You See on the Oracle HCM Cloud Source Request Page

What You Can Do from the Oracle HCM Cloud Source Request Page
You can select the following source request values for Oracle HCM Cloud.

Select the specific type to receive as a request from Oracle HCM Cloud:

• Select to receive a business object as a request from Oracle HCM Cloud. This
selection invokes the integration.

What You See on the Oracle HCM Cloud Source Request Page
The following table describes the key information on the Oracle HCM Cloud source
Request page.

Element Description

Select Business Object Select the business object from the Oracle
HCM Cloud application to receive as a
request that starts the integration.

Object Name Filter Enter the initial letters of the name to filter
the display of business objects.

Name Displays the name of the selected business
object.

Description Displays a description of the selected
business object.

Configuring Oracle HCM Cloud Source Request Properties
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Configuring Oracle HCM Cloud Source Response Properties
Enter the Oracle HCM Cloud source response values for your integration.

Topics

• What You Can Do from the Oracle HCM Cloud Source Response Page

• What You See on the Oracle HCM Cloud Source Response Page

What You Can Do from the Oracle HCM Cloud Source Response Page
You can configure the operation and business object that comprise the response type
for Oracle HCM Cloud.

• Immediate (synchronous) response: A response business object is immediately
returned as output. You select Immediate as the response type on the Response
page and select the business object as part of the response to the client.

• No response is required: You select None on the Response page because a response
is not required.

What You See on the Oracle HCM Cloud Source Response Page
Select the business object for the integration to send as a response document to the
Oracle HCM Cloud application.

The following types of responses are available.

• Immediate: A synchronous response is required (See Table 5-1 for instructions)

• None: No response is required (See Table 5-2 for instructions)

The following table describes the fields available if an immediate (synchronous)
response is required.

Table 5-1    Response Type — Immediate (Synchronous) Response is Required

Element Description

Immediate Response Select Immediate for the Oracle HCM Cloud
application to wait until a response is
received from the integration. This is also
known as the request and response message
exchange pattern. This is the default
selection.

Also Send faults Select this checkbox if you want to send fault
information to the Oracle HCM Cloud
application if any errors are encountered by
the integration while processing the request.
This is an optional checkbox only available
with the Immediate response type.

Object Name Filter Enter the initial letters to filter the display of
business objects.

Configuring Oracle HCM Cloud Source Response Properties
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Element Description

Select the business object to receive from the
Oracle HCM Cloud application as a response.

Select Business Object Select the business object to receive from the
Oracle HCM Cloud application as a response.
A description of the selected business object
is displayed below this list.

Name Displays the name of the selected business
object.

Description Displays the description of the selected
business object.

The following table describes the fields available if no response is required.

Table 5-2    None — No Response is Required

Element Description

Send Deselect if a response is not required. This
option disables the selection of business
objects because none are required.

Response Type If you deselect the Send checkbox, this
section is disabled.

Select Business Object If you deselect the Send checkbox, this
section is disabled.

Configuring Oracle HCM Cloud Target Operation Properties
Enter the Oracle HCM Cloud target operation values for your integration.

Topics

• What You Can Do from the Oracle HCM Cloud Target Operations Page

• What You See on the Oracle HCM Cloud Target Operations Page

What You Can Do from the Oracle HCM Cloud Target Operations Page
You can configure the following target operation values for the Oracle HCM Cloud.

• Select the business object or service.

• Select the operation to perform on the selected business object or service.

Configuring Oracle HCM Cloud Target Operation Properties
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What You See on the Oracle HCM Cloud Target Operations Page
The following table describes the key information on the Oracle HCM Cloud target
Operations page.

Element Description

Browse by Select to browse by business object or service.
There is a one-to-one correspondence
between the business object and service. The
service acts on the business document.

• Business Objects: Select to browse a list
of available business objects.

• Services: Select to browse a list of
available services.

Object Filter Name Enter the initial letters to filter the display of
business objects.

Business Objects Select the business object or service to use.

Select the operation to perform on the
business object or service

Select the operation to perform on the
selected business object or service.

Life Cycle Displays the state of the selected business
object or service. Deprecated indicates the
business document is nearing the end of use
and must be used with caution.

Name Displays the name of the selected business
object or service.

Description Displays the description of the selected
business object or service.

Reviewing Configuration Values on the Summary Page
You can review the specified source or target adapter configuration values on the
Summary page.

Topics

• What You Can Do from the Summary Page

• What You See on the Summary Page

What You Can Do from the Summary Page
You can review source or target configuration details from the Summary page. The
Summary page is the final wizard page for each adapter after you have completed
your configuration.

• View the configuration details you defined for the source or target adapter. For
example, if you have defined an inbound Oracle RightNow Cloud source adapter

Reviewing Configuration Values on the Summary Page
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with a request business object and immediate response business object, specific
details about this configuration are displayed on the Summary page.

• Click Done if you want to save your configuration details.

• Click a specific tab in the left panel to update your configuration definitions.

What You See on the Summary Page
The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard. To return to a previous
page to update any values, click the
appropriate tab in the left panel.

Reviewing Configuration Values on the Summary Page
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6
Managing Applications

This section describes how to monitor an Oracle SOA Suite or Oracle Service Bus
application that uses the Oracle HCM Cloud adapter from Oracle Enterprise Manager
Fusion Middleware Control or Oracle Service Bus Console.

Topics

• Managing the Application in Oracle Enterprise Manager Fusion Middleware
Control

• Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service
that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. In the navigator, expand the tree to display your SOA composite application or
Oracle Service Bus business service project (for this example, a SOA composite
application is selected).

3. Select the SOA composite application.
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4. Click Test.

The Test Web Service page is displayed.

5. Complete the fields on the page to initiate a test of your composite.

6. Click Test Web Service.

Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise
Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle
Business Process Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus
Console

You can test Oracle Service Bus business service projects from Oracle Service Bus
Console.

1. Log in to Oracle Service Bus Console.

2. In the navigator under All Projects, open the project to test.

Testing Oracle Service Bus Business Services from Oracle Service Bus Console
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3. In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.

This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed
under the Response Document section.

For more information about testing Oracle Service Bus business service projects,
see Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus Console
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